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本資料は表記のバージ ョ ンの英語版を翻訳したもので、内容に相違が生じる場合には原文を優先します。 資料によっては英語版の更新に対応していないものがあります。 日本
語版は参考用としてご使用の上、 最新情報につきましては、 必ず最新英語版をご参照く ださい。

概要
ザイ リ ンクスの LogiCORE™ IP AXI Chip2Chip コアは、複数デバイスで構成されるシステムオンチップ (SoC) ソ リ ューシ ョ
ン向けに、Advanced eXtensible Interface (AXI) を使用してシステムを接続するブリ ッジ機能を提供します。 このアプ リ ケー
シ ョ ン ノー ト では、 Kintex®-7 FPGA KC705 評価ボード を 2 つ使用した場合、 または KC705 ボード と  Zynq®-7000 All
Programmable (AP) SoC ZC706 評価ボードを使用した場合のリ アルタイム ビデオ ト ラフ ィ ッ クをデモンス ト レーシ ョ ンし
ます。AXI Chip2Chip コアは、SMA データ  コネクタ  ケーブルを使用して 2 つのボード間にコネクティビティを提供します。

このアプリ ケーシ ョ ン ノートの リ ファレンス  デザイン ファ イルは、 ザイ リ ンクスのウェブサイ トからダウンロードでき
ます。 リ ファレンス  デザイン ファ イルの詳細は、 「 リ ファレンス  デザイン」 を参照してください。

含まれるシステム
リ ファレンス  デザインには、Vivado® Design Suite : System Edition 2014.1 の IP インテグレーター (IPI) の機能を使用して作
成された 2 つの統合システムがあ り ます。 Vivado Design Suite を利用するこ とによって、 IP ブロ ッ クをインスタンシエー
ト、 コンフ ィギュレーシ ョ ン、および接続して複雑な統合システムを構築する作業が簡略化されます。 このデザインには、
ザイ リ ンクスのソフ ト ウェア開発キッ ト  (SDK) を使用して構築されたソフ ト ウェア アプリ ケーシ ョ ンも含まれます。この
アプリ ケーシ ョ ンは、 MicroBlaze™ エンベデッ ド  プロセッサまたは ARM® Cortex™-A9 MPCore™ アプリ ケーシ ョ ン プロ
セッサ上で動作し、制御、 ステータス、モニターの各機能を実行します。 リ ファレンス  デザインには IP インテグレーター
および SDK の完全なプロジェク ト  ファ イルが含まれており、 デザインの検討や再構築に活用した り、 新規デザインのテ
ンプレート と して使用できます。

はじめに
AXI Chip2Chip コアは、 AXI プロ ト コル仕様に基づいて複数デバイス間の AXI ト ランザクシ ョ ンをつなぎ、 少ないピンで
高性能な AXI ピン間ブ リ ッジ ソ リ ューシ ョ ンを提供し ます ( 『AMBA AXI4 仕様』 [参照 1] および 『LogiCORE IP AXI
Chip2Chip 製品ガイ ド』 (PG067) [参照 2] 参照)。

このコアがサポートする  PHY 層インターフェイスのタイプは、 次のとおりです。

• シングル データ  レート  (SDR) SelectIO™ インターフェイス

• ダブル データ  レート  (DDR) SelectIO インターフェイス

• Aurora 64B/66B シ リ アル データ  ス ト リーム

この リ ファレンス  デザインでは、 LogiCORE IP Aurora 64B/66B コアを  PHY 層と して使用して AXI Chip2Chip コアの性能
を示します。

リ ファレンス  デザインは、 AXI System I および AXI System II とい う  2 つのプラ ッ ト フォームに実装されています (図 1 参
照)。
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各プラ ッ ト フォームは、 別々のハード ウェア評価キッ ト  ボードに実装されます。 リ ファレンス  デザインには、 次の 2 つ
バージ ョ ンがあ り ます。

1. 2 つの Kintex-7 FPGA KC705 評価ボード間の相互接続を示す。

2. KC705 ボード と  Zynq-7000 AP SoC ZC706 評価ボード間の相互接続を示す。

リ ファレンス  デザインは、 Test Pattern Generator (TPG) コアがソース  ビデオ信号を生成するビデオ システムを実装してい
ます。1 つはマスター、1 つはスレーブとする合計 2 つの AXI Chip2Chip コアのインスタンスがインスタンシエート されて
います。 AXI Chip2Chip コアのマスターとスレーブ両方のインスタンスは、 AXI ス ト リーミ ング インターフェイスを介し
て Aurora 64B/66B コアへ接続しています。 マスター Chip2Chip コアは AXI マスター モードの Aurora 64B/66B コアへ接続
し、 スレーブ Chip2Chip コアは AXI スレーブ モードの Aurora 64B/66B コアへ接続します。 Aurora コアは、 SMA コネクタ
およびケーブルを使用して相互接続されます。

AXI System I プラ ッ ト フォームには、 AXI VDMA (Video Direct Memory Access) リ ファレンス  デザイン [参照 4] が含まれ、
マスター Chip2Chip コアが AXI 7 シ リーズ FPGA DDRx メモ リ  コン ト ローラー に取って代わり ます。AXI System II プラ ッ
ト フォームには、 AXI スレーブ モードのスレーブ Chip2Chip コアへ接続された実際の AXI 7 シ リーズ FPGA DDRx メモ リ
コン ト ローラーが含まれます。 AXI System II プラ ッ ト フォームの AXI スレーブ ペリ フェ ラルのメモ リ領域をマスター
Chip2Chip コアへマップするこ とで、AXI System I プラ ッ ト フォームの AXI マスター ペリ フェラルが AXI System II プラ ッ
ト フォーム上のスレーブ ペリ フェラルへアクセス可能になり ます。

AXI System I にはマスター モードの AXI Chip2Chip コアが含まれるため、 AXI System I プラ ッ ト フォームがマスター プ
ラ ッ ト フォームに指定されています。同様に、AXI System II プラ ッ ト フォームがスレーブ プラ ッ ト フォームに指定されて
います。

図 2 に、 この リ ファレンス  デザイン ブロ ッ クの詳細とその相互接続を示します。 AXI System I プラ ッ ト フォームの AXI
VDMA ブロ ッ ク  (ボード  A) は、 マスターおよびスレーブ Chip2Chip コアの AXI4 インターフェイスを介して、 AXI System
II プラ ッ ト フォーム (ボード  B) の外部メモ リに対してビデオ データの読み書きを実行します。 ボード  A の MicroBlaze プ
ロセッサは、 ローカル AXI4-Lite イ ン ターコネク ト へ接続するビデオ ペ リ フ ェ ラルを構成しています。 ボード  B の
ARM/MicroBlaze プロセッサは、 ローカル AXI4-Lite インターコネク トへ接続するペリ フェラルを構成しています。

X-Ref Target - Figure 1

図 1 : AXI Chip2Chip コアの一般的な相互接続
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ZC706 がスレーブ プラ ッ ト フォームのリ ファレンス  デザインでは、 125MHz の外部基準クロ ッ ク  ソースが 2 つ必要です。
このリ ファレンス  デザインの再現には、 適切に調整された 125MHz ク ロ ッ ク  ソースであればどれでも利用可能です。

AXI ト ランザクシ ョ ンを生成するマスター デバイスで AXI VDMA ブロ ッ クを置き換えるこ とによ り、 AXI Chip2Chip コ
アを使用する同様のデザインを作成できます。 また、外部メモ リ  ブロ ッ クは、 AXI ト ランザクシ ョ ンを受信する任意のス
レーブ デバイスに置き換えるこ とができます。

X-Ref Target - Figure 2

図 2 : リファレンス デザインの詳細ブロック図
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ハードウェア要件

KC705 スレーブ プラッ ト フォーム バージ ョ ン

• Kintex-7 FPGA KC705 評価ボード  (x 2)

• 評価ボード用の電源アダプター (x 2)

• HDMI™ ケーブル (x 1)

• 解像度を指定できるディ スプレイ  モニター (HDMI ケーブルを使用して、 Dell 社製 U2410F モニターで検証)

• Type-A/Mini-B の 5 ピン USB ケーブル (x 1)

• JTAG プラ ッ ト フォーム USB ケーブル (x 2)

• シ リ アル データ用 SMA コネクター ケーブル (x 4)

ZC706 スレーブ プラッ ト フォーム バージ ョ ン

• Kintex-7 FPGA KC705 評価ボード  (x 1) および Zynq-7000 AP SoC ZC706 評価ボード  (x 1)

• 評価ボード用の電源アダプター (x 2)

• HDMI™ ケーブル (x 1)

• 解像度を指定できるディ スプレイ  モニター (HDMI ケーブルを使用して、 Dell 社製 U2410F モニターで検証)

• Type-A/Mini-B の 5 ピン USB ケーブル (x 1)

• JTAG プラ ッ ト フォーム USB ケーブル (x 2)

• 外部の差動 125MHz SMA ク ロ ッ ク  ソース  (x 2)

• シ リ アル データ用 SMA コネクタ  ケーブル (x 4)

• 外部クロ ッ ク  ソース用の SMA コネクタ  ケーブル (x 4)

ソフ トウェア要件
AXI Chip2Chip リ ファレンス  デザインのソフ ト ウェア要件は次のとおりです。

• Vivado Design Suite 2014.1 : System Edition

リファレンス システム仕様
リ ファレンス  デザインには、 次の 2 つのバージ ョ ンがあ り ます。

1. 2 つの Kintex-7 FPGA KC705 評価ボード間の相互接続を示す。

2. KC705 ボード と  Zynq-7000 AP SoC ZC706 評価ボード間の相互接続を示す。

各リ ファレンス  デザインには、 マスター プラ ッ ト フォームと スレーブ プラ ッ ト フォームが 1 つずつあ り ます。 マスター
システムは、 リ ファレンス  デザインの両バージ ョ ンで共通しており、 次のコアを含みます。

• AXI Chip2Chip

• Aurora 64B/66B

• AXI Interconnect

• Clock Generator

• Processor System Reset Module (proc_sys_reset)
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• AXI IIC Bus Interface

• AXI GPIO

• AXI Interrupt Controller (INTC)

• Video Timing Controller (VTC)

• Test Pattern Generator (TPG)

• AXI Video Direct Memory Access (VDMA)

• AXI Performance Monitor

• On-Screen Display (OSD)

• HDMI Interface コア

• 外部 SMA ク ロ ッ ク  ソース

表 1 には、 マスター プラ ッ ト フォームのペリ フェラルのアドレス  マップを示します。

Kintex-7 FPGA のスレーブ プラ ッ ト フォームには、 次のコアが含まれます。

• 7シ リーズ FPGA メモ リ  インターフェイス  ソ リ ューシ ョ ン

• AXI Chip2Chip (スレーブ モード )

• Aurora 64B/66B

• MicroBlaze Processor

• AXI Interconnect

• AXI GPIO

• Clock Generator

• Processor System Reset Module

表 1 :  AXI System I プラッ ト フォームのアドレス マップ

ペリフェラル インスタンス インターフェイス ベース アドレス 上位アドレス

axi_chip2chip axi_chip2chip_0 s_axi 0x20000000 0x3FFFFFFF

bram_if_cntlr lmb_bram_if_cntlr_1 slmb 0x00000000 0x0001FFFF

mig_7series mig_7series_0 s_axi 0x80000000 0x9FFFFFFF

axi_gpio axi_gpio_0 s_axi 0x40000000 0x4000FFFF

axi_gpio axi_gpio_1 s_axi 0x40010000 0x4001FFFF

axi_iic axi_iic_1 s_axi 0x40800000 0x4080FFFF

axi_intc axi_intc_1 s_axi 0x41200000 0x4120FFFF

axi_perf_mon axi_perf_mon_0 s_axi 0x44A10000 0x44A1FFFF

axi_timer axi_timer_1 s_axi 0x41C00000 0x41C0FFFF

axi_uartlite axi_uartlite_1 s_axi 0x40600000 0x4060FFFF

axi_vdma axi_vdma_1 s_axi_lite 0x44A20000 0x44A2FFFF

mdm mdm_1 s_axi 0x41400000 0x41400FFF

v_cresample v_cresample_0 ctrl 0x44A30000 0x44A3FFFF

v_osd v_osd_1 ctrl 0x44A40000 0x44A4FFFF

v_rgb2ycrcb v_rgb2ycrcb_0 ctrl 0x44A50000 0x44A5FFFF

v_tc v_tc_1 ctrl 0x44A60000 0x44A6FFFF

v_tpg v_tpg_1 ctrl 0x44A70000 0x44A7FFFF

axi_chip2chip axi_chip2chip_0 s_axi_lite 0x50000000 0x5000FFFF
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表 2 には、 Kintex-7 FPGA スレーブ プラ ッ ト フォームのペリ フェラルのアドレス  マップを示します。

Zynq-7000 AP SoC には、プロセッシング システム (PS) が含まれています。 スレーブ プラ ッ ト フォームの PS は、UART お
よび DDR メモ リ  コン ト ローラーを含むよ うに構成されています。 DDR コン ト ローラーは、 HP0 ポート を介してアクセス
します。 この PS は、 M_AXI_GP1 ポート を介して、 マスター プラ ッ ト フォーム ボード上の AXI4-Lite ビデオ ペリ フェラ
ルを制御します。

Zynq-7000 AP SoC のスレーブ システムには次のコアが含まれます。

• AXI Interconnect

• AXI Chip2Chip (スレーブ モード )

• Aurora 64B/66B

• AXI GPIO

• Clock Generator

• Processor System Reset Module

表 3 には、 Zynq-7000 AP SoC スレーブ プラ ッ ト フォームのペリ フェラルのアドレス  マップを示します。

表 2 :  AXI System II Platform (KC705) のアドレス マップ

ペリフェラル インスタンス インターフェイス ベース アドレス 上位アドレス

axi_bram_ctrl axi_bram_ctrl_0 s_axi 0xE0000000 0xE000FFFF

axi_gpio axi_gpio_0 s_axi 0x40000000 0x4000FFFF

axi_gpio axi_gpio_2 s_axi 0x40010000 0x4001FFFF

axi_uartlite axi_uartlite_0 s_axi 0x40600000 0x4060FFFF

bram_if_cntlr microblaze_0_local_memory slmb 0x00000000 0x00001FFF

axi_intc microblaze_0_axi_intc s_axi 0x41200000 0x4120FFFF

mig_7series mig_7series_0 s_axi 0x20000000 0x3FFFFFFF

表 3 :  AXI System II Platform (ZC706) のアドレス マップ

ペリフェラル インスタンス インターフェイス ベース アドレス 上位アドレス

axi_gpio axi_gpio_0 s_axi 0x41200000 0x4120FFFF

axi_gpio axi_gpio_1 s_axi 0x41210000 0x4121FFFF

Mig_7series Processing_system7_1 s_axi 0x00000000 0x3FFFFFFF
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KC705 および ZC706 評価ボードには LED があ り、 動作中のリ ファレンス  システムのステータスを表します。 表 4 には、
各プラ ッ ト フォームで使用される  LED の割り当てを示します。

ハードウェア システム仕様
こ こでは、 AXI Chip2Chip コアのコンフ ィギュレーシ ョ ンについて説明します。 VDMA コンフ ィギュレーシ ョ ンのハード
ウェア システムおよびその他のビデオ関連 IP コアに関する情報は、 『AXI VDMA リ ファレンス  デザイン』 (XAPP742) [参
照 4] を参照してください。AXI システムの最適化および設計上のト レードオフに関する詳細は、『Vivado Design Suite : AXI
リ ファレンス  ガイ ド』 (UG1037) [参照 6] を参照してください。

AXI System I プラッ ト フォームの設定

AXI Chip2Chip コア マスター インスタンス (master_c2c)

マスター モードで動作する場合、AXI Chip2Chip コアを 1 つまたは複数の AXI マスター ペリ フェラルのスレーブと して設
定できます。 スレーブ モードで動作する場合は、 このコアを 1 つまたは複数の AXI スレーブ ペリ フェラルのマスターと
して設定できます。

AXI Chip2Chip コアの動作は、 独立クロ ッキング モードまたは共通クロ ッキング モードのいずれかに設定できます。 独立
クロ ッキング モードでは、 PHY 層インターフェイスの動作クロ ッ クを AXI ク ロ ッ ク と異なる周波数に設定できます。 共
通クロ ッキング モードでは、 ク ロ ッ ク乗せ換えによるレイテンシが抑えられます。

AXI データ幅は、 システム要件に応じて 32 ビッ ト または 64 ビッ トのいずれかを選択できます。 Chip2Chip の [PHY Type]
および [PHY Width] パラ メーターによ り、デバイス間接続に使用する  I/O ピンの数が決ま り ます。次に示す 3 つの PHY 層
インターフェイスがサポート されています。

• SDR SelectIO インターフェイス

• DDR SelectIO インターフェイス

• Aurora 64B/66B シ リ アル データ  ス ト リーム

コンパク ト  2:1 および 4:1 オプシ ョ ンを利用する と、必要な I/O ピンの数を減らすこ とができます。すべてのコンパク ト率
がすべての PHY 層インターフェイスでサポート されているわけではあ り ません。 たとえば、 Aurora PHY 層インターフェ
イスがサポートするのは、 コンパク ト  2:1 およびコンパク ト  1:1 のみです。

表 4 :  プラッ ト フォームの LED 割り当て

ピン名 LOC 値 LED

KC705 マスター プラッ ト フォーム

axi_c2c_link_status_out AA8 GPIO_LED_1

axi_c2c_config_error_out AB8 GPIO_LED_0

axi_c2c_link_error_out AE26 GPIO_LED_4

axi_c2c_multi_bit_error_out AC9 GPIO_LED_2

KC705 スレーブ プラッ ト フォーム

axi_c2c_link_status_out AA8 GPIO_LED_1

axi_c2c_config_error_out AB8 GPIO_LED_0

axi_c2c_multi_bit_error_out AC9 GPIO_LED_2

ZC706 スレーブ プラッ ト フォーム

axi_c2c_config_error_out G2 GPIO_LED_CENTER

axi_c2c_link_status_out Y21 GPIO_LED_LEFT

axi_c2c_multi_bit_error_out W21 GPIO_LED_RIGHT
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この リ ファレンス  デザインでは、 64 ビッ トの AXI Chip2Chip コア マスター インスタンスを独立ク ロ ッキング モードで
PHY 層の動作周波数を 250MHz に設定しています。AXI Chip2Chip コアの AXI4 および AXI4-Lite インターフェイスは、マ
スター モード と しています。720p のリ アルタイム ビデオ ト ラフ ィ ッ ク信号の送受信に必要なデータ  レート を確保するた
め、 [PHY Type] に [Aurora 64B/66B] を、 [PHY Width] に [Compact 2-1] を選択しています。 AXI の [WUser Width] は 1 ビッ
トに設定しています (図 3 参照)。

X-Ref Target - Figure 3

図 3 : AXI Chip2Chip コアのマスター モード  コンフ ィギュレーシ ョ ン
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Aurora 64B/66B

AXI Chip2Chip コアのこのコンフ ィギュレーシ ョ ンで、 Aurora 64B/66B コアは PHY 層と して機能します。 Aurora コアは、
GT 基準クロ ッ クに 125MHz の外部 SMA ク ロ ッ クを使用します。ライン レートは、全二重データ  フロー モードで 6.25Gb/s
に設定されています。 2 つのマスター プラ ッ ト フォームは、 同じコンフ ィギュレーシ ョ ンを使用します。 マスター プラ ッ
ト フォームの Aurora の [Core Options] タブで図 4 のよ うに設定する必要があ り ます。[GT Selections] タブでは、図 5 のよ う
に、 レーンが Quad-2 (GTXQ2) のト ランシーバーに割り当てられているこ とを確認してください。

注記 : GTXQ2 ト ランシーバーは、 KC705 ボードの SMA コネク タへ割り当てられる唯一の ト ランシーバーです。 リ ス ト
ボッ クスの設定の上にカーソルを置く と、 ツールチップが表示されて選択した ト ランシーバーの位置を確認できます。

[Shared Logic] タブでは、 図 6 のよ うに [include Shared Logic in core] がオンになっているこ とを確認してください。

X-Ref Target - Figure 4

図 4 : マスター プラッ ト フォームの Aurora 64B/66B の [Core Options] タブ
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X-Ref Target - Figure 5

図 5 : マスター プラッ ト フォームの Aurora 64B/66B の [GT Selections] タブ
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AXI Performance Monitor

AXI Performance Monitor コアは、 AXI4 インターコネク ト  システム内の主要なパフォーマンス基準を測定します。 このコ
アは、 プロセッサからレジスタにアクセスするためのスレーブ AXI4-Lite インターフェイスで構成されています。 AXI
Performance Monitor コアは、AXI スレーブと  AXI インターコネク ト間の読み出しチャネルおよび書き込みチャネルをモニ
ターするのみです。 このコアが、 モニターしている  AXI ト ランザクシ ョ ンを修正するこ とはあ り ません。

AXI Performance Monitor コアは、 さまざまなパフォーマンス基準を測定できます。 次に例を示します。

• 読み出しバイ ト総数

• 書き込みバイ ト総数

• 読み出し要求

• 書き込み要求

• 書き込み応答

X-Ref Target - Figure 6

図 6 : マスター プラッ ト フォームの Aurora 64B/66B の [Shared Logic] タブ
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カウン トの開始および終了条件は、レジスタ  インターフェイスを介してプロセッサから送られます。コアのグローバル ク
ロ ッ ク  カウンターが、カウン トの開始イベン ト と終了イベン ト間のクロ ッ ク数を測定します。パフォーマンス  モニターで
使用されるカウンターは、 レジスタ  インターフェイスを介して 32 ビッ ト または 64 ビッ トに設定できます。ユーザーが選
択可能な最終的な基準値もレジスタ  インターフェイスを介して読み出すこ とができます。

リ ファレンス  デザインでは、マスター AXI Chip2Chip コアのスレーブ AXI インターフェイスをモニターし、パフォーマン
ス基準をレポート します。

マスター システムのクロッキング

マスター プラ ッ ト フォームのクロ ッキング要件は、 リ ファレンス  デザインのバージ ョ ンによって異なり ます。KC705 ボー
ド上の Aurora 64B/66B コアは、KC705 ボード  スレーブ プラ ッ ト フォーム バージ ョ ンの内部クロ ッ クを使用します。ZC706
スレーブ プラ ッ ト フォーム バージ ョ ンには、GT 基準クロ ッ ク用に 125MHz の外部 SMA ク ロ ッ クが必要です。KC705 ボー
ドは、 コネクタ  J15 および J16 で外部 SMA ク ロ ッ クを受信します。

SMA データ接続

マスター プラ ッ ト フォームとスレーブ プラ ッ ト フォーム間は、 コネク タ  J17、 J18、 J19 および J20 を使用して SMA デー
タ  ケーブルで接続されます。

AXI System II プラッ ト フォームの設定

AXI Chip2Chip コア スレーブ インスタンス (slave_c2c)

この リ ファレンス  デザインでは、 64 ビッ トの AXI Chip2Chip コア スレーブ インスタンスを独立ク ロ ッキング モードで
PHY 層の動作周波数を 250MHz に設定しています。AXI Chip2Chip コアの AXI4 および AXI4-Lite インターフェイスは、ス
レーブ モード と しています。720p のリ アルタイム ビデオ ト ラフ ィ ッ ク信号の送受信に必要なデータ  レート を確保するた
め、 [PHY Type] に [Aurora 64B/66B] を、 [PHY Width] に [Compact 2-1] を選択しています。 AXI の [WUser Width] は 1 ビッ
トに設定しています (図 7 参照)。 通常、 AXI4 および AXI4-Lite モードを除くすべてのパラ メーターは、 AXI Chip2Chip コ
アのマスター インスタンス と同じになるよ うに設定します。
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Aurora 64B/66B

AXI Chip2Chip コアのこのコンフ ィギュレーシ ョ ンで、 Aurora 64B/66B コアは PHY 層と して機能します。 Aurora コアは、
GT 基準クロ ッ クに 125MHz の外部 SMA ク ロ ッ クを使用します。ライン レートは、全二重データ  フロー モードで 6.25Gb/s
に設定されています。 2 つのスレーブ プラ ッ ト フォームは、マスター プラ ッ ト フォームと同じコンフ ィギュレーシ ョ ンを
使用します。KC705 ボードまたは ZC706 のいずれかを使用するスレーブ プラ ッ ト フォームの Aurora コアの [Core Options]
タブで図 8 のよ うに設定する必要があ り ます。

X-Ref Target - Figure 7

図 7 : AXI Chip2Chip コアのスレーブ モード  コンフ ィギュレーシ ョ ン
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KC705 ボードを使用するスレーブ プラ ッ ト フォームの Aurora コアの [GT Selections] は、 図 9 のよ うにな り ます。 図のよ
うに、 レーンがクワッ ド  2 (GTXQ2) の最初のト ランシーバーに割り当てられているこ とを確認して ください。

注記 : GTXQ2 ト ランシーバーは、 KC705 ボードの SMA コネク タへ割り当てられる唯一の ト ランシーバーです。 リ ス ト
ボッ クスの設定の上にカーソルを置く と、 ツールチップが表示されて選択した ト ランシーバーの位置を確認できます。

X-Ref Target - Figure 8

図 8 : スレーブ プラッ ト フォームの Aurora 64B/66B の [Core Options] タブ
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ZC706 ボードを使用するスレーブ プラ ッ ト フォームの Aurora コアの [GT Selections] は、 図 10 のよ うになり ます。 図のよ
うに、 レーンがクワッ ド  2 (GTXQ2) の 2 つ目のト ランシーバーに割り当てられているこ とを確認してください。

X-Ref Target - Figure 9

図 9 : KC705 スレーブ プラッ ト フォームの Aurora 64B/66B の [GT Selections] タブ
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[Shared Logic] タブでは、 図 11 のよ うに [include Shared Logic in core] がオンになっているこ とを確認してください。

X-Ref Target - Figure 10

図 10 : ZC706 スレーブ プラッ ト フォームの Aurora 64B/66B の [GT Selections] タブ
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スレーブ プラッ ト フォームのメモリ  システム

KC705 スレーブ プラ ッ ト フォームでは、 7 シ リーズ デバイス  メモ リ  インターフェイス  ソ リ ューシ ョ ン コアを使用して
DDR3 SDRAM デバイス とのインターフェイスを作成します。AXI インターフェイスは、64 ビッ トで動作周波数は 200MHz
に設定しています。 7 シ リーズ デバイス  メモ リ  インターフェイス  ソ リ ューシ ョ ン コアは、読み出し /書き込み受け入れ数
を 2、 書き込み/読み出し深さを 512 と しています。 AXI4 インターコネク ト  メモ リ  コン ト ローラー ポート  FIFO は有効に
しています。 メモ リ  インターフェイス  ソ リ ューシ ョ ン コアの詳細は、『Zynq-7000 SoC および 7 シ リーズ デバイス  メモ リ
インターフェイス  ソ リ ューシ ョ ン』 (UG586) [参照 7] を参照して ください。

ZC706 スレーブ プラ ッ ト フォームの場合、 AXI Chip2Chip コアは PS の高性能 (HP) スレーブ AXI4 インターフェイスへ接
続します。 HP ポートは、 プログラマブル ロジッ ク  (PL) 内の AXI マスターと  PS の DDR3 メモ リ を接続する高スループッ
トのデータパス と して利用できます。

スレーブ システムのクロッキング

スレーブ プラ ッ ト フォームのクロ ッキング要件は、 リ ファレンス  デザインのバージ ョ ンによって異なり ます。KC705 ボー
ド上の Aurora 64B/66B コアは、KC705 ボード  スレーブ プラ ッ ト フォーム バージ ョ ンの内部クロ ッ クを使用します。ZC706
スレーブ プラ ッ ト フォーム バージ ョ ンには、 GT 基準クロ ッ ク用に 125MHz の外部 SMA ク ロ ッ クが必要です。 KC705 ス
レーブ プラ ッ ト フォームのクロ ッキングは、KC705 マスター プラ ッ ト フォームと同じです。外部 SMA ク ロ ッ クが KC705
ボード上の J15 および J16 に接続されます。

ZC706 スレーブ プラ ッ ト フォームでは、 外部 SMA ク ロ ッ クが ZC706 ボード上の J36 および J31に接続されます。

X-Ref Target - Figure 11

図 11 : スレーブ プラッ ト フォームの Aurora 64B/66B の [Shared Logic] タブ
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シリアル ト ランシーバー コネクタ

マスター プラ ッ ト フォームと スレーブ プラ ッ ト フォーム間は、 SMA データ  ケーブルで接続します。 データ  ケーブルは、
KC705 ボード上の J17、 J66、 J19、 J20、 および ZC706 ボード上の J32、 J33、 J34、 J35 へ接続します。

ソフ トウェアアプリケーシ ョ ン
マスター プラ ッ ト フォーム (ボード  A) 用のアプ リ ケーシ ョ ン ソフ ト ウェアで AXI4-Lite スレーブを設定します。 ソフ ト
ウェア アプリ ケーシ ョ ンの詳細は、 『AXI VDMA リ ファレンス  デザイン』 (XAPP742) [参照 4] を参照してください。

ハードウェアの構築
このセクシ ョ ンでは、 ハード ウェア デザインを再構築する方法について説明します。 プロジェ ク ト を再構築する前に、
Vivado design suite 2014.1: System Edition が適切にインス トールされているこ とを確認してください。

マスター プラッ ト フォームを再構築する

1. このアプリ ケーシ ョ ン ノートに付属する リ ファレンス  デザイン ファ イルを解凍します (28 ページの 「リ ファレンス
デザイン」 参照)。 デザイン ファ イルが置かれるローカル ホルダーを <unzip dir> と します。

注記 : Windows ワークステーシ ョ ンでは、 ソース  フォルダーにある長いパス名と合う よ うに、 選択したド ラ イブの
ルート  ディ レク ト リにデザイン ファ イルを置く必要がある場合があ り ます。

2. Vivado Design Suite を起動します。

3. [Open Project] をク リ ッ ク して、 次のワークスペースを選択します。

KC705 スレーブ プラ ッ ト フォームの場合 : 

<unzip_dir>/c2c_aurora/kintex-kintex/HW/master/project_1/project_1.xpr

ZC706 スレーブ プラ ッ ト フォームの場合 :

<unzip_dir>/c2c_aurora/kintex-zynq/HW/master/project_1/project_1.xpr

4. [OK] をク リ ッ ク します。

5.  [Flow] → [Generate Bitstream] をク リ ッ ク、または Flow Navigator で [Program and Debug] の下にある  [Generate Bitstream]
をク リ ッ ク します。合成およびインプリ メンテーシ ョ ンの実行を開始する画面が表示されたら、 [Yes] をク リ ッ ク しま
す。

http://japan.xilinx.com
http://japan.xilinx.com/about/feedback.html?docType=Application_Notes&docId=XAPP1216&Title=%26%2312522%3B%26%2312450%3B%26%2312523%3B%26%2312479%3B%26%2312452%3B%26%2312512%3B%20%26%2312499%3B%26%2312487%3B%26%2312458%3B%20%26%2312450%3B%26%2312503%3B%26%2312522%3B%26%2312465%3B%26%2312540%3B%26%2312471%3B%26%2312519%3B%26%2312531%3B%20%26%2321521%3B%26%2312369%3B%20AXI%20Chip2Chip%20Aurora%20%26%2312522%3B%26%2312501%3B%26%2312449%3B%26%2312524%3B%26%2312531%3B%26%2312473%3B%20%26%2312487%3B%26%2312470%3B%26%2312452%3B%26%2312531%3B&releaseVersion=1.0&docPage=18


ハードウェアの構築

XAPP1216 (v1.0) 2014 年 8 月 12 日 japan.xilinx.com  19

スレーブ プラッ ト フォームを再構築する

1. 必要に応じて、 このアプリ ケーシ ョ ン ノートに付属する リ ファレンス  デザイン ファ イルを解凍します (28 ページの
「リ ファレンス  デザイン」 参照)。 デザイン ファ イルが置かれるローカル ホルダーを <unzip dir> と します。

2. Vivado Design Suite を起動します。

3. [Open Project] をク リ ッ ク して、 次のワークスペースを選択します。

KC705 スレーブ プラ ッ ト フォームの場合 :

<unzip_dir>/c2c_aurora/kintex-kintex/HW/slave/project_1/project_1.xpr

ZC706 スレーブ プラ ッ ト フォームの場合 :

<unzip_dir>/c2c_aurora/kintex-zynq/HW/slave/project_1/project_1.xpr

4. [OK] をク リ ッ ク します。

5. [Flow] → [Generate Bitstream] をク リ ッ ク、または Flow Navigator で [Program and Debug] の下にある  [Generate Bitstream]
をク リ ッ ク します。合成およびインプリ メンテーシ ョ ンの実行を開始する画面が表示されたら、 [Yes] をク リ ッ ク しま
す。

SDK でソフ トウェア アプリケーシ ョ ンをコンパイルする

1. SDK を起動します。

2. Workspace Launcher で、 次のよ うにワークスペース  パスを選択して [OK] をク リ ッ ク します。

KC705 スレーブ プラ ッ ト フォームの場合 : 

<unzip_dir>/c2c_aurora/kintex-kintex/SW/master/SW

ZC706 スレーブ プラ ッ ト フォームの場合 :

<unzip_dir>/c2c_aurora/kintex-zynq/SW/master/SW

3. [Project] → [Build All] をク リ ッ ク します。

4. ワークスペースに SDK のプロジェク トが表示されない場合は、 次の手順に従って SDK プロジェク ト をインポート し
て ください。

a. [File] → [Import] をク リ ッ ク します。

b. [General] → [Existing Projects into Workspace] をク リ ッ ク します。

c. [Next] をク リ ッ ク します。

d. 次のルート  ディ レク ト リに移動します。

KC705 スレーブ プラ ッ ト フォームの場合 :

<unzip_dir>/c2c_aurora/kintex-kintex/SW/master/SW

ZC706 スレーブ プラ ッ ト フォームの場合 :

<unzip_dir>/c2c_aurora/kintex-zynq/SW/master/SW

e. [Finish] をク リ ッ ク します。

これでボード  サポート  パッケージ (BSP) と ソフ ト ウェア アプ リ ケーシ ョ ンがコンパイルされます。 この処理には最大 5
分ほどかかり ます。完了する と、SDK 内で既存ソフ ト ウェア アプリ ケーシ ョ ンの変更や新規ソフ ト ウェア アプリ ケーシ ョ
ンの作成が可能になり ます。
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ハードウェア上でのリファレンス デザインの実行

KC705 スレーブ プラッ ト フォーム システムをセッ トアップする

この例では、マスター プラ ッ ト フォームおよびスレーブ プラ ッ ト フォームと して機能する  2 つの Kintex-7 FPGA KC705 評
価ボード間のリ アルタイム ビデオ ト ラフ ィ ッ クを示します (3 ページの図 2 参照)。マスター プラ ッ ト フォームとなる  AXI
System I (ボード  A) は、 SMA データ  ケーブルを使用してスレーブ プラ ッ ト フォームの AXI System II (ボード  B) と接続し
ています。 図 12 に KC705 ボードのコネクタを示します。

次の手順のかっこ内の番号は図 12 に示す番号に対応しています。両端 SMA コネクタ付きケーブルを使用して、次の接続
を行います。

1. ボード  A の TXP (6) をボード  B の RXP (7) へ接続します。

2. ボード  A の TXN (9) をボード  B の RXN (8) へ接続します。

3. ボード  B の TXP (6) をボード  A の RXP (7) へ接続します。

4. ボード  B の TXN (9) をボード  A の RXN (8) へ接続します。

特定ケーブルを使用して、 次の接続を行います。

1. Type-A/Mini-B の 5 ピン USB ケーブルを使用して、ホス ト  PC からボード  A (1) の USB UART ポートへ接続します。ホ
ス ト  PC に適切なデバイス  ド ラ イバーがインス トールされているこ とを確認します。『Kintex-7 FPGA KC705 評価キッ
ト  スタート アップ ガイ ド』 (UG883) [参照 11] を参照してください。

2. JTAG プラ ッ ト フォーム USB ケーブルをボード  A のプラ ッ ト フォーム ケーブル ヘッダー (3) へ接続します。

3. JTAG プラ ッ ト フォーム USB ケーブルをボード  B のケーブル ヘッダー (3) へ接続します。

4. HDMI ビデオ ケーブルを使用して、 ボード  A の HDML コネク タ  (2) から解像度 1280 x 720p で 60Hz のビデオ信号を
表示できるモニターへ接続します。

5. KC705 ユニバーサル 12v 電源アダプター ケーブルを両方のボードの電源コネクタ  (11) へ接続します。

X-Ref Target - Figure 12

図 12 : KC705 ボードのコネクタ
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6. 両方のボードの電源スイ ッチ (10) を ON の位置に設定します。

セッ ト アップが完了する と、 図 13 のよ うにな り ます。

X-Ref Target - Figure 13

図 13 : KC705 マスター プラッ ト フォームから  KC705 スレーブ プラッ ト フォームへのセッ トアップ
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KC705 スレーブ プラッ ト フォーム リファレンス デザインを実行する

1. ホス ト  PC 上で、 次の設定を使用してハイパーターミナルなどの端末プログラムを起動します。

° ボー レート  : 9600

° データ  ビッ ト  : 8

° パリティ  : なし

° ス ト ップ ビッ ト  : 1

° フロー制御 : なし

2. JTAG プラ ッ ト フォーム USB ケーブルを使用して、 ボード  B からホス ト  PC へ接続します。

3. コマンド  シェルまたはターミナル ウ ィンド ウで、 次のコマンドを実行してスレーブ ダウンロード  ディ レク ト リに移
動します。

% cd <unzip_dir>/c2c_aurora/kintex-kintex/ready_for_download/slave

4. Xilinx Microprocessor Debugger ツールを起動します。

Windows の場合 : 

[スタート ] → [すべてのプログラム] → [Xilinx Design Tools] → [SDK 2014.1] → [Xilinx Microprocessor Debugger 2014.1]
をク リ ッ ク します。

Linux の場合 : 

% xmd

5. ビッ ト ス ト リーム ファ イルをボード  B にダウンロード します。

XMD% fpga -f design_1_wrapper.bit

6. XMD コマンド  プロンプ ト を終了します。

XMD% exit

7. JTAG プラ ッ ト フォーム USB ケーブルを使用して、 ボード  A からホス ト  PC へ接続します。

8. コマンド  シェルまたはターミナル ウ ィンド ウで、 次のコマンドを実行してマスター ダウンロード  ディ レク ト リに移
動します。

% cd <unzip_dir>/c2c_aurora/kintex-kintex/ready_for_download/master

9. Xilinx Microprocessor Debugger ツールを起動します。

Windows の場合 : 

[スタート ] → [すべてのプログラム] → [Xilinx Design Tools] → [SDK 2014.1] → [Xilinx Microprocessor Debugger 2014.1]
をク リ ッ ク します。

Linux の場合 : 

% xmd

10. ビッ ト ス ト リーム ファ イルをボード  A にダウンロード します。

XMD% fpga -f design_1_wrapper.bit
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11. プロセッサを接続します。

XMD% connect mb mdm

12. ソフ ト ウェアのダウンロード時にシステム全体のリセッ ト を無効にします。

XMD% debugconfig -reset_on_run system disable

13. プロセッサを リセッ ト します。

XMD% rst -processor

14. プロセッサ コード  ファ イルをダウンロード します。

XMD% dow app_vp.elf

15. リ ファレンス  システムを実行します。

XMD% run

16. 両方のボード上にある  axi_c2c_link_status_out LED (AA8) が点灯しているこ とを確認します。 LED の定義に
ついては、 7 ページの表 4 を参照してください。

17. ハイパーターミナル コンソールに表示される メニューから、 パターンを  1 つ選択します。

26 ページの 「ハード ウェアおよびソフ ト ウェアの実行結果」 へ進みます。

ZC706 スレーブ プラッ ト フォーム システムをセッ トアップする

この例では、マスター プラ ッ ト フォームと して機能する  Kintex-7 FPGA KC705 評価ボード と スレーブ プラ ッ ト フォーム
と して機能する  Zynq-7000 AP SoC ZC706 評価ボード間のリ アルタイム  ビデオ ト ラフ ィ ッ クを示します (3 ページの図 2
参照)。 マスター プラ ッ ト フォームとなる  AXI System I (ボード  A) は、 SMA データ  ケーブルを使用してスレーブ プラ ッ
ト フォームの AXI System II (ボード  B) と接続しています。 さ らに、 SMA ケーブルを使用して、 125MHz の外部クロ ッ ク
ソースをマスター プラ ッ ト フォームと スレーブ プラ ッ ト フォームに接続します。20 ページの図 12 に KC705 ボードのコ
ネク タを示します。 図 14 に ZC706 ボードのコネク タを示します。

次の手順のかっこ内の番号は、 KC705 (ボード  A) の場合は 20 ページの図 12、 ZC706 (Board B) の場合は図 14 に示す番号
に対応しています。 両端 SMA コネクタ付きケーブルを使用して、 次の接続を行います。

X-Ref Target - Figure 14

図 14 : ZC706 ボードのコネクタ
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1. ボード  A の TXP (6) をボード  B の RXP (5) へ接続します。

2. ボード  A の TXN (9) をボード  B の RXN (6) へ接続します。

3. ボード  B の TXP (7) をボード  A の RXP (7) へ接続します。

4. ボード  B の TXN (8) をボード  A の RXN (8) へ接続します。

5. ク ロ ッ ク  ソース  1 の CLKP をボード  A の MGT CLK P (4) へ接続します。

6. ク ロ ッ ク  ソース  1 の CLKN をボード  A の MGT CLK N (5) へ接続します。

7. ク ロ ッ ク  ソース  2 の CLKP をボード  B の MGT CLK P (3) へ接続します。

8. ク ロ ッ ク  ソース  2 の CLKN をボード  B の MGT CLK N (4) へ接続します。

特定ケーブルを使用して、 次の接続を行います。

1. Type-A/Mini-B の 5 ピン USB ケーブルを使用して、ホス ト  PC からボード  A (1) の USB UART ポートへ接続します。ホ
ス ト  PC に適切なデバイス  ド ラ イバーがインス トールされているこ とを確認します。『Kintex-7 FPGA KC705 評価キッ
ト  スタート アップ ガイ ド』 (UG883) [参照 11] を参照してください。

2. JTAG プラ ッ ト フォーム USB ケーブルをボード  A のプラ ッ ト フォーム ケーブル ヘッダー (3) へ接続します。

3. JTAG プラ ッ ト フォーム USB ケーブルをボード  B のプラ ッ ト フォーム ケーブル ヘッダー (1) へ接続します。

4. HDMI ビデオ ケーブルを使用して、 ボード  A の HDML コネク タ  (2) から解像度 1280 x 720p で 60Hz のビデオ信号を
表示できるモニターへ接続します。

5. KC705 ユニバーサル 12v 電源アダプター ケーブルをボード  A の電源コネクタ  (11) へ接続します。

6. ZC706 ユニバーサル 12v 電源アダプター ケーブルをボード  B の電源コネクタ  (10) へ接続します。

7. ボード  A の電源スイ ッチ (10) とボード  B の電源スイ ッチ (9) を ON の位置にします。

セッ ト アップが完了する と、 図 15 のよ うにな り ます。
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ZC706 スレーブ プラッ ト フォーム リファレンス デザインを実行する

1. ホス ト  PC 上で、 次の設定を使用してハイパーターミナルなどの端末プログラムを起動します。

° ボー レート  : 9600

° データ  ビッ ト  : 8

° パリティ  : なし

° ス ト ップ ビッ ト  : 1

° フロー制御 : なし

2. JTAG プラ ッ ト フォーム USB ケーブルを使用して、 ボード  B からホス ト  PC へ接続します。

3. コマンド  シェルまたはターミナル ウ ィンド ウで、 次のコマンドを実行してスレーブ ダウンロード  ディ レク ト リに移
動します。

% cd <unzip_dir>/c2c_aurora/kintex-zynq/ready_for_download/slave

4. Xilinx Microprocessor Debugger ツールを起動します。

Windows の場合 : 

[スタート ] → [すべてのプログラム] → [Xilinx Design Tools] → [SDK 2014.1] → [Xilinx Microprocessor Debugger 2014.1]
をク リ ッ ク します。

X-Ref Target - Figure 15

図 15 : KC705 マスター プラッ ト フォームから  ZC706 スレーブ プラッ ト フォームへのセッ トアップ
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Linux の場合 : 

% xmd

5. ボード  B に Tcl ソース  ファ イルを読み込みます。

XMD% source slave.tcl

6. XMD コマンド  プロンプ ト を終了します。

XMD% exit

7. JTAG プラ ッ ト フォーム USB ケーブルを使用して、 ボード  A からホス ト  PC へ接続します。

8. コマンド  シェルまたはターミナル ウ ィンド ウで、 次のコマンドを実行してマスター ダウンロード  ディ レク ト リに移
動します。

% cd <unzip_dir>/c2c_aurora/kintex-zynq/ready_for_download/master

9. Xilinx Microprocessor Debugger ツールを起動します。

Windows の場合 : 

[スタート ] → [すべてのプログラム] → [Xilinx Design Tools] → [SDK 2014.1] → [Xilinx Microprocessor Debugger 2014.1]
をク リ ッ ク します。

Linux の場合 : 

% xmd

10. ビッ ト ス ト リーム ファ イルをボード  A にダウンロード します。

XMD% fpga -f design_1_wrapper.bit

11. プロセッサを接続します。

XMD% connect mb mdm

12. ソフ ト ウェアのダウンロード時にシステム全体のリセッ ト を無効にします。

XMD% debugconfig -reset_on_run system disable

13. プロセッサを リセッ ト します。

XMD% rst -processor

14. プロセッサ コード  ファ イルをダウンロード します。

XMD% dow app_vp.elf

15. リ ファレンス  システムを実行します。

XMD% run

16. 両方のボード上にある  axi_c2c_link_status_out LED (KC705 は AA8、 ZC706 は Y21) が点灯しているこ とを確
認します。 LED の定義については、 7 ページの表 4 を参照して ください。

17. ハイパーターミナル コンソールに表示される メニューから、 パターンを  1 つ選択します。

ハードウェアおよびソフ トウェアの実行結果

リ ファレンス  デザインの2 つのバージ ョ ンは、 同じ結果にな り ます。 この例では、 解像度 720p のみサポート されていま
す。 デザインを実行する際、 ハイパーターミナル コンソールの画面は図 16 と同じになる必要があ り ます。
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1. ハイパーターミナル コンソールを使用して、 いずれかのオプシ ョ ンを選択してモニター画面で確認します。

° 0 : 水平ランプ パターンを表示

° 1 : 垂直ランプ パターンを表示

° 2 : 全画面赤を表示

° 3 : 全画面緑を表示

° 4 : 全画面青を表示

° 5 : カラー バー パターンを表示

° 6 : ゾーン プレート を表示

° 7 : 格子バー パターンを表示

° 8 : ク ロスハッチ パターンを表示

° 9 : 端末上にパフォーマンス関連の基準を表示

X-Ref Target - Figure 16

図 16 :ハイパーターミナルの出力 : パターン選択メニュー
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これらのオプシ ョ ン選択後、 ハイパーターミナル コンソール画面が図 17 のよ うになり ます。

リ ファレンス  デザインで使用される  Chip2Chip の理論上の帯域幅は 1.5GB/s です。720p のビデオ ト ラフ ィ ッ クに必要な帯
域幅は 0.332GB/s です。 有効な DDR 帯域幅の割合は、 6.09% (0.390/6.4) です。 ハイパーターミナル コンソールに表示され
る値は、 こ こに示す例とは異なる場合があ り ます。

リファレンス デザイン
このアプリ ケーシ ョ ン ノートの リ ファレンス  デザイン ファ イルは、 ザイ リ ンクスのウェブサイ トからダウンロードでき
ます。

表 5 に、 リ ファレンス  デザインの詳細を示します。

X-Ref Target - Figure 17

図 17 :端末出力 : メニュー選択

表 5 :  リファレンス デザインの詳細

パラメーター 説明

全般

ターゲッ ト  デバイス Kintex-7 FPGA および Zynq-7000 AP SoC

ソース  コードの提供 あ り

ソース  コードの形式 VHDL、 Verilog

既存のザイ リ ンクス  アプリ ケーシ ョ ン ノート、リ
ファレンス  デザイン、またはサードパーティから
デザインへのコード /IP の使用

あ り
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デザインの特性

リ ファレンス  デザインは、 Vivado Design Suite 2014.1 を使用して、 Kintex-7 FPGA (XC7K325T-2FFG900) およびオプシ ョ ン
と して Zynq-7000 AP SoC (XC7Z045-2FFG900C) デバイスをターゲッ トに実装されています。

使用率とパフォーマンス

表 6 に、 KC705 スレーブ プラ ッ ト フォーム リ ファレンス  デザインのリ ソース使用率を示します。

表 7 に、 ZC706 スレーブ プラ ッ ト フォーム リ ファレンス  デザインのリ ソース使用率を示します。

表 8 と表 9 は、各バージ ョ ンの リ ファレンス  デザインにおける  AXI Chip2Chip コアのマスターおよびスレーブ インスタン
スのデバイス  リ ソース使用率を示したものです。 これらの表に示す情報は、 XPS の [Design Overview] → [Module Level
Utilization] を選択して表示される  [Design Summary] タブから取得しています。 モジュールの境界を越えたロジッ ク最適化
やモジュール間のロジッ ク共有などがあるため、 使用率の情報は概算値です。

シミ ュレーシ ョ ン

論理シ ミ ュレーシ ョ ンの実施 N/A

タイ ミ ング シ ミ ュレーシ ョ ンの実施 N/A

論理シ ミ ュレーシ ョ ンおよびタ イ ミ ング シ ミ ュ
レーシ ョ ンでのテス トベンチの利用

N/A

テス トベンチの形式 N/A

使用したシ ミ ュレータ /バージ ョ ン N/A

SPICE/IBIS シ ミ ュレーシ ョ ンの実施 N/A

インプリ メンテーシ ョ ン

使用した合成ツール/バージ ョ ン Vivado synthesis 

使用したイ ンプ リ メ ンテーシ ョ ン ツール/バー
ジ ョ ン

Vivado Design Suite 2014.1

スタティ ッ ク  タイ ミ ング解析の実施 あ り  (配置配線でタイ ミ ング検証に合格)

ハードウェア検証

ハードウェア検証の実施 あ り

使用したハード ウェア プラ ッ ト フォーム KC705 評価ボード  (x 2)、 ZC706 評価ボード  (x 1)

表 6 :  KC705 スレーブ プラッ ト フォーム リファレンス デザインのリソース使用率

モード LUT スライス 
レジスタ

メモリ DSP IO ト ランシー
バー チャネル

クロッキング

マスター 42,636 47,797 88 15 154 1 15

スレーブ 21,491 21,633 6 0 16 1 10

表 7 :  ZC706 スレーブ プラッ ト フォーム リファレンス デザインのリソース使用率

モード LUT スライス 
レジスタ

メモリ DSP IO ト ランシー
バー チャネル

クロッキング

マスター 42,636 47,797 88 15 154 1 15

スレーブ 2,739 5,417 6 0 16 1 10

表 5 :  リファレンス デザインの詳細 (続き)

パラメーター 説明
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注記 : スライスには、 複数の IP コアおよび階層からの基本エレ メン ト をパッ クできます。 したがって、 パッ ク された基本
エレ メン ト を共有する各階層モジュールに対して 1 スライスがカウン ト されます。 その結果、 全モジュールのスライス数
を合計する と、 スラ イスが重複して数えられます。

KC705 スレーブ プラ ッ ト フォーム ボードのセッ ト アップでは、AXI データ幅を 64 ビッ ト 、PHY を動作周波数 125MHz の
コンパク ト  2:1 Aurora 64B/66B モード と しています。Aurora 64B/66B コアは、101.56MHz (6.5Gb/s/64 bits) のユーザー ク ロ ッ
クを必要とする  6.5Gb/s ライン レート用に構成されます。AXI Chip2Chip コアおよび Aurora 64B/66B コアは、マスター AXI
Chip2Chip コアへの入力と して送信される平均ト ラフ ィ ッ ク よ り も理論上のスループッ ト  (式 1) が大き くなるよ うに設定
する必要があ り ます。

式 1

Chip2Chip コアのオーバーヘッ ドは、プロ ト コルが 12.5% および ECC が 12.5% です。たとえば AXI データ幅を 64 ビッ ト 、
Aurora PHY 層を動作周波数 125MHz のコンパク ト  2:1 と した場合、 コアの理論上のスループッ トは 375MB/s とな り ます。
したがって、 この構成では、 1080p60 を可能にする帯域幅 0.747GB/s を必要とするフレーム解像度 1920x1080 をサポート
できません。帯域幅の要件が高くなるほど、 Aurora 64B/66B コアはよ り高いライン レートに対応するよ うに設定する必要
があ り ます。

多重化率によって、 AXI Chip2Chip コアの [PHY Width] パラ メーターが決定します。

• 1 : コンパク ト  1:1

• 2 : コンパク ト  2:1

• 4 : コンパク ト  4:1

表 8 :  KC705 スレーブ プラッ ト フォーム リファレンス デザインのモジュール レベル のリソース使用率

IP コア モード LUT スライス 
レジスタ

メモリ DSP IO ト ランシー
バー チャネル

クロッキング

AXI Chip2Chip マスター 1,165 2,201 5 0 N/A 0 0

AXI Chip2Chip スレーブ 1,069 2,121 5 0 N/A 0 0

表 9 :  ZC706 スレーブ プラッ ト フォーム リファレンス デザインのモジュール レベルのリソース使用率

IP コア モード LUT スライス 
レジスタ

メモリ DSP IO ト ランシー
バー チャネル

クロッキング

AXI Chip2Chip マスター 1,165 2,201 5 0 N/A 0 0

AXI Chip2Chip スレーブ 1,099 2,187 5 0 N/A 0 0

Throughput 0.75 AXIDataWidth
MuxingRatio

‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ PHYFrequency=
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式 1 は、 バース ト長が 1 のシステムに適用されます。 リ ファレンス  デザインは、 AW、 AR、 および W (または AR および
B) AXI4 インターフェイス  データを多重化するためにプライオ リ テ ィ  エンコード方式を実行します。 つま り、 よ り長い
バース ト長のシステムで、 指定したスロ ッ トが空の場合に、 有効なチャネルからのデータが多重化されて送信されます。
たとえば、 AW および AR チャネルにデータがない場合、 W チャネルからのデータが送信されます。 したがって、 バース
ト長が長いシステムの理論上の帯域幅は、 式 1 で算出される値よ り も大き くな り ます (因数 0.75 を無視)。

表 10 に、 異なる  AXI Chip2Chip コア コンフ ィギュレーシ ョ ンで必要な入力 I/O 数と出力 I/O 数を示します。 影付きの行
は、 リ ファレンス  デザインで選択したコンフ ィギュレーシ ョ ンを示しています。低いデータ  レート または少ないピン数を
使用する場合は、 表 10 および式 1 を使用して適切な設定を判断できます。

表 10 :  AXI Chip2Chip コア コンフ ィギュレーシ ョ ンの FPGA I/O 使用率

AXI データ幅 Chip2Chip PHY タイプ 多重化率 入力 I/O 数 出力 I/O 数

32

SelectIO SDR
コンパク ト  4:1 19 19

コンパク ト  2:1 31 31

SelectIO DDR

コンパク ト  4:1 10 10

コンパク ト  2:1 16 16

コンパク ト  1:1 29 29

64

SelectIO SDR
コンパク ト  4:1 26 26

コンパク ト  2:1 45 45

SelectIO DDR

コンパク ト  4:1 14 14

コンパク ト  2:1 23 23

コンパク ト  1:1 42 42

Aurora 64b/66b
コンパク ト  2:1 1 レーン 1 レーン

コンパク ト  1:1 2 レーン 2 レーン
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